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Chapter 1: Introduction

About This Document

This document contains information on configuring and using Mercury
Financial Management™ in conjunction with Mercury Project Management™,
Mercury Program Management™, or Mercury Portfolio Management™, along
with Mercury Time Management™.

This document contains the following chapters:

Chapter 1, Introduction, on page 11

Includes an overview of Mercury Financial Management and details the
document’ sintended audience and related guides.

Chapter 2, Working with Budgets, on page 15

This chapter describes how budgets can interact with various Mercury I T
Governance Center™ entities, as well as how to create, configure, and
anayze them.

Chapter 3, Managing Financial Exchange Rates and Currencies,
on page 27

This chapter explains how currency display and financial exchange rates
are handled in Mercury Financial Management, as well as the role of
regions. Creation and modification of currencies, FX rates, and regions are
also explained.

Chapter 4, Tracking and Analyzing Financial Data, on page 39

This chapter discusses how cost datais captured and calculated by Mercury
Financial Management, as well as analyses available for examining this
datain Mercury Project Management and Mercury Program Management.

Chapter 5, SOP 98-1 Compliance, on page 65

This chapter explains how to use Mercury Financial Management’ s built-in
capabilities for tracking capitalized costs to achieve SOP 98-1 compliance.

Appendix A: Financial Management Portlets on page 89

This appendix lists portlets that display Mercury Financial Management
data.

12

Mercury Financial Management™ User’s Guide



Chapter 1: Introduction

e Appendix B: Reports by Category on page 93

This appendix lists the reports delivered as part of Mercury IT Governance
Center.

Who Should Read This Document

This book isfor the following audience types.

End users

For More Information

For information about audience types, see the Guide to Documentation.

Related Documents

Related documents for this book are:

Guide to Documentation

Key Concepts

Getting Sarted

Mercury Project Management User’s Guide
Mercury Program Management User’s Guide
Mercury Portfolio Management User’s Guide
Mercury Resour ce Management User’s Guide

Mercury Time Management User’s Guide

For More Information

For information about these documents and how to access them, see the Guide
to Documentation.

Who Should Read This Document 13



Chapter 1: Introduction

Overview of Mercury Financial Management

The Mercury IT Governance Center™ features a set of functionality
collectively referred to as Mercury Financial Management. Mercury Financial
Management enables you to do the following:

e Create and monitor budgets (see Working with Budgets for more detailed
information)

= Budgets associated with entities such as projects, project plans,
programs, and organization units can be used to track financial
performance

= Budgets can be compared with each other on the project or
organization unit level

e Useand display multiple currenciesin one installation of the Mercury IT
Governance Center (see Managing Financial Exchange
Rates and Currencies for more detailed information)

= Currency display can be user-based or entity-based

= Currency values are tracked against each other using financial
exchange rates

e Track actual cost datain project plans (see Tracking and Analyzing
Financial Data for more detailed information)

m Task cost values can be rolled up into project plans from time sheets

» Task cost values can be rolled up into project budgets from project
plans

= Project budgets can berolled up into program budgets from project
plans or their budgets

s EV analysis can be performed on project cost data

e Monitor SOP 98-1 compliance (see SOP 98-1 Compliance for more
detailed information)

n  Capitalization can be tracked at the task level
»  Capital exposure can be monitored at the portfolio level

= Capitalization can be built into process using project templates

14
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Chapter

Working with Budgets

In This Chapter:

e Creating Budgets
= Configuring Access to a Budget
e Setting Budget Associations
= Projects and Project Plans
= Programs
e Modifying Budgets
e Comparing Budgets
s Comparing Planned to Actual Values
s Comparing Related Budgets

15



Chapter 2: Working with Budgets

Creating Budgets

Once created, budgets can be used to track financial information for a project,
project plan, program, organization unit, or other entity. Budgets can be linked
to these entities with varying levels of data dependency. See Setting Budget
Associations and Cost Rollup in Budgetsfor Project Plans on page 51 for more
details.

To create a budget:

1.

2.

Log on to Mercury IT Governance Center.
From the menu bar, select Create > Budget.

The Create a New Budget page opens.

. Enter the Budget Name.

. Enter any other desired information relating to the budget’ s associations.

For more information, see Setting Budget Associations.

. Select aregion from the Select Region auto-complete list.

This determines the budget’ s currency settings.

. Enter the budget’ s Start Period and Finish Period.

. Click continue.

The Create a New Budget: Enter Details page opens.

. Enter any desired information in the Budget Information Section.

This includes the budget’ s associated entities and roll-up settings, if you
did not already specify them. See Setting Budget Associations for more
information.

. To add lines to the budget, scroll down to the Budget Breakdown Section.

a. Click Add Budget Lines.
The Add Lines to Budget page opens.

b. Specify a Type and Category for the budget line.

16
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Chapter 2: Working with Budgets

c. Click Add Another if you want to add additional lines.
d. When you have finished adding lines, click Add.

10. The Create a New Budget: Enter Details page reloads with the budget lines
added.

11. If you want to manually enter actual amountsfor your budget alongside the
planned amounts, select the Plan and Actuals option in the Show line and
click Apply. The Create a New Budget: Enter Details page reloads with Actuals
fields enabling you to fill in actual values next to the planned amountsin
the budget’ s columns.

Budget amounts can be entered in whole dollars as well as in thousands. To enter
budget amounts in whole dollars, the parameter BUDGET_IN_WHOLE_DOLLARS

should be set to True in the server. conf file.

Note Usually, only Mercury IT Governance Center system administrators have access to
the Mercury IT Governance Center server. Contact your system administrator with
any questions about altering the server. conf file.

12. Click Create.

Configuring Access to a Budget

Access to a budget can be granted to individual users during a budget’s
creation, or after the budget has already been created. Additionally, there are
different levels of possible access that can be granted.

Granting Access to a User

To grant a user access to a budget:
1. Create a new budget or open an existing one.
2. Click configure Access at the top of the page.
The Configure Access for Budget page opens.
3. Select a user from the Give Access to User auto-complete list.
4. Click Add.

The user is added to the View Access list.

Creating Budgets 17



Chapter 2: Working with Budgets

5. Click Save.

The user has been granted View access to the budget. To configure further
budget security options for the user, see Configuring Existing User Access.

Configuring Existing User Access

User accessto a budget can be further configured once the user has been added
to the View Access list. The available options are listed in Table 2-1.

Table 2-1. Additional editing access for a budget

Field Description
Edit Basic Budget Allows the user to edit basic budget information such as
Information Name, Description, Status, and so forth.

Allows the user to edit the budget’s lines and enter new

Edit Plan and Actuals values in the Actuals fields.

Edit Actuals Allows the user to enter new values in the Actuals fields.

Edit Security Allows the user to configure access to the budget.

The user access described in this section is applicable to users with the View
Budgets and Edit Budgets access grants. A user with either of these access grants
who appears on this list can view the budget.

A listed user with the Edit Budgets access grant can edit specific parts of the budget
Note that have been selected in the list.

A user who is not listed cannot view the budget unless given the Edit All Budgets
access grant. Users with the Edit All Budgets access grant have access to edit all
budgets regardless of whether they appear on the budgets’ Configure Access pages.

To configure existing user access:
1. Create a new budget or open an existing one.
2. Click configure Access at the top of the page.

The Configure Access for Budget page opens.

18 Mercury Financial Management™ User’s Guide



Chapter 2: Working with Budgets

3. Select or desdlect the desired checkboxes in the Additional Editing Access
section.

See Table 2-1 for descriptions of each category.

4. Click save.

Setting Budget Associations

Budgets can be associated with projects, project plans, and programs. Data
from project plans can be rolled up into these linked budgets as actual values.
See Cost Rollup in Budgets for Project Plans on page 51 for more details.

Projects and Project Plans

Y ou can associate a budget with an existing project plan. If this project planis
already linked to a project in your portfolio, the budget is also linked to that
project.

If the project plan hasits Financial Management capabilities activated from the
Project Settings window, the cost data calculated in the project plan can be
rolled up into the budget. For more information on linking cost data from
project plans into budgets, see Cost Rollup in Budgets for Project Plans

on page 51.

To associate a budget with a project plan and set it to roll up actual values:

1. Verify that the project plan you want to associate with the budget has
Financial Management turned on.

See Configuring Cost in the Project Settings Window on page 42 for more
information.

2. Create a budget or modify an existing one and click Change.
The Change Properties for Budget page opens.
3. From the This is a __ Budget drop-down list, select Project Plan.

4. Select the desired project plan from the auto-complete list.

Setting Budget Associations 19



Chapter 2: Working with Budgets

5. From the Actuals are radio buttons, select Automatically Rolled up from
project information.

6. Click Change.
The budget will roll up actuals from the project plan’ s tasks and report
them as subtotals in each budget line category.
Programs

Y ou can associate a budget with an existing program. Furthermore, you can set
this program budget to automatically roll up actual values from the budgets of
the projectsin the program.

To associate a budget with a program and set it to roll up actual values:
1. Create abudget or modify an existing one and click Change.
The Change Association for Budget page opens.
2. From the This is a __ Budget drop down list, select Program.
3. Select the desired program from the auto-complete list.

4. From the Actuals are radio buttons, select Automatically Rolled up from
project information.

5. Click Change.

The budget will roll up actuals from the program’ s projects and report them
as subtotals in each budget line category.

20 Mercury Financial Management™ User’s Guide



Chapter 2: Working with Budgets

Modifying Budgets
Once created, budgets can be modified. Budgets can be accessed from the
standard interface from at least two locations:

e Selecting Search > Budgets from the menu bar, you can search for and
open existing budgets to which you have access.

e Selecting Cost > Budgets > Modify Budgets opens a search page that can be
used to locate and open existing budgets to which you have access. Y ou
can also delete budgets and create new budgets directly from this page.

To modify an existing budget:
1. Open the budget and click Modify Budget to open the Modify Budget page.
2. Make any necessary changes.

a. To configure security options for the budget, click Configure Access to
open the Configure Access for Budget page.

b. After you've made your changes, click Save.

3. Click save.

Comparing Budgets

The Budget to Budget Comparison portlet allows you to make a number of
comparisons between budgets, aswell as compare abudget’ s planned valuesto
itsactuals.

Aswith al portlets, the Budget to Budget Comparison portlet’s Edit page allows
you to choose parameters for the portlet’ s filtering and display of information.
These parameters are listed in Table 2-2.

Modifying Budgets 21



Chapter 2: Working with Budgets

Table 2-2. Budget to Budget Comparison portlet parameters

Field

Description

Compare One or
More Budgets

A multi-select auto-complete field that allows you to select
one or more budgets.

To Actuals

Compares the selected budget(s) to its actual values,
assuming any have been entered.

To Active Child
Budgets

Compares the selected budget(s) to the budgets that roll up
into it (child budgets).

To Active Child
Budget Actuals

Compares the selected budget(s) to the actual values
entered for its child budgets.

To Another Set of
Budgets

Compares the selected budget(s) to another set of budgets.
This is another multi-select auto-complete list. You can
select to use the planned or actual values in the comparison.

Time Period
Covered by
Budgets

Limits the portlet’s display range to the time period covered
by the selected budget(s).

Show From/To

Allows you to select a period range to display.

Comparing Planned to Actual Values

The Budget to Budget Comparison portlet can be used to compare a budget’s
planned valuesto its actual values, if actual values are being captured. To see
how to capture actual values for a budget, see Creating Budgets on page 16.

Y ou can compare asingle budget’ s planned and actual values, as shown in
Figure 2-1. Thisis accomplished by selecting a budget from the Compare One
or More Budgets field and selecting the To Actuals option on the Budget to Budget
Comparison portlet’s Edit page.

22
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Chapter 2: Working with Budgets

Budget To Budget Comparison

Preferences: Comparison of Allocation Budgets: Team S Alloc..

% {in Thousands)

1104 1204

Maonth

0405

Allocation Budgets: [l Team S Allocations

7 JEdit O]

Figure 2-1. Comparison of a single budget’s planned and actual values

In the example shown in Figure 2-1, the actual values for the first month of
this budget went over its planned amounts by afairly significant margin, while
the second month stayed even, and no values have been entered for the last

month.

You might also find it useful to compare planned and actual valuesfor a set of
budgets, as shown in Figure 2-2. Thisis accomplished by selecting multiple
budgets from the Compare One or More Budgets field and selecting the To
Actuals option on the Budget to Budget Comparison portlet’ s Edit page.

Comparing Budgets 23
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Budget To Budget Comparison [Edit

Preferences: Comparison of Allocation Budgets: Team S Alloc..

% {in Thousands)

a0 —
a0 -
20—
20—
10—

a-

1104 12404 01405

Month
Allocation Budgets: [l Team S Allocations W Team T Allocations

Figure 2-2. Comparison of planned and actual values for multiple budgets

In the example shown in Figure 2-2 the miscellaneous projects belonging to
Team S always seem to go over budget, while Team T is consistently under
budget.

Comparing Related Budgets

The Budget to Budget Comparison portlet can also be used to compare sets of
related budgets, as shown in Figure 2-3. Thisis accomplished by selecting a
budget or budgets from the Compare One or More Budgets field and the To
Another Set of Budgets option and multi-select auto-complete list on the Budget
to Budget Comparison portlet’s Edit page.
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Org Unit to Project Budget Comparison

Preferences: Comparizson of Allocation Budgets: T Ops Alloc..,

% {in Thousands)

25

20

15

5]

1004 1104 1204

Month

0105

Allocation Budgets: M IT Ops Allocstions

Allocated Budgets:
Project &

7 JEdit O]

0205

Work Core Budgetary [l Infrastructure
Fedeployment

Figure 2-3. Comparing related budgets

The portlet shown in Figure 2-3 compares the budget for an entire IT
organization unit with two project budgets owned by its members. During
almost every month, the combined budgets for these projects exceeds that of
the organization unit, in some cases by a wide margin.
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Overview of Financial Exchange Rates and Currencies

The Mercury IT Governance Center can display cost datafor entities such as
projects and budgets in different currencies depending on the region each
entity is associated with. A particular entity can only be associated with one
region at atime, meaning the entity’s cost datawill display in only one
currency, which would be the region’ slocal currency or the base currency used
by the system. Financial exchange (FX) rates are used to calculate the
exchange rates between aloca currency and the base currency.

Access to currencies, FX rates and regions is controlled through access grants and
@: security groups. For details on the security surrounding currencies, FX rates, and

regions, see the Security Model Guide and Reference.

Managing Currencies and FX Rates

Y ou can select new currencies to be available for display. You can also create

new FX rates, aswell as maintain existing ones.

Adding a Currency

Currencies can be made available for display in the system. Table 3-1 lists all

the currencies you can pick from.

Table 3-1. Available currencies in Mercury IT Governance Center (page 1 of

5)
Currency Code Currency Name
AFN Afghani
ARS Argentine Peso
AUD Australian Dollar
ATS Austrian Schilling (Euro)
AZM Azerbaijani Manat
BSD Bahamian Dollar
BHD Bahraini Dinar
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Table 3-1. Available currencies in Mercury IT Governance Center (page 2 of
5)

Currency Code Currency Name
BDT Bangladesh Taka
BEF Belgian Franc (Euro)
BOB Bolivian Boliviano
BAM Bosnia-Herzegovina Convertible Marks
BWP Botswana Pula
BRL Brazilian Real
GBP British Pound
BGN Bulgarian Lev (since 1999-07-05)
XAF Chad CFA Franc BEAC
CAD Canadian Dollar
CLP Chilean Peso
CNY Chinese Renmibi Yuan
COP Colombian Peso
HRK Croatian Kuna
DKK Danish Krone
DEM Deutsche Mark (Euro)
EGP Egyptian Pound
EEK Estonian Kroon
EUR Euro
FJD Fiji Dollar
FIM Finnish Markka (Euro)
FRF French Franc (Euro)
GRD Greek Drachma (Euro)
GTQ Guatemalan Quetzal
HKD Hong Kong Dollar
HUF Hungarian Forint
ISK Iceland Krona
INR Indian Rupee
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Table 3-1. Available currencies in Mercury IT Governance Center (page 3 of

5)
Currency Code Currency Name
IDR Indonesian Rupiah
IRR Iranian Rial
IQD Iraqgi Dinar
IEP Irish Pound (Euro)
ITL Italian Lira (Euro)
JPY Japanese Yen
JOD Jordanian Dinar
KZT Kazakhstan Tenge
KES Kenyan Shilling
KWD Kuwaiti Dinar
LAK Lao Kip
LVL Latvian Lats
LBP Lebanese Pound
LTL Lithuanian Litus
LUF Luxembourg Franc (Euro)
MKD Macedonian (Former Yug. Rep.) Denar
MGA Malagasy ariary
MGF Malagasy Franc
MYR Malaysian Ringgit
MXN Mexican Peso
MNT Mongolian Tugrik
NPR Nepalese Rupee
NLG Netherlands Guilder (Euro)
ILS New Israeli Shekel
TWD New Taiwan Dollar
NZD New Zealand Dollar
NGN Nigerian Naira
KPW North Korean Won
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Table 3-1. Available currencies in Mercury IT Governance Center (page 4 of
5)

Currency Code Currency Name
NOK Norwegian Krone
OMR Omani Rial
PKR Pakistani Rupee
PAB Panama Balboa
PGK Papua New Guinea Kina
PEN Peruvian Nuevo Sol
uyu Peso Uruguayo
PHP Philippine peso
PLN Polish Zloty
PTE Portuguese Escudo (Euro)
QAR Qatari Rial
ROL Romanian Leu
RUB Russian Ruble
SAR Saudi Riya
CSD Serbian Dinar
SGD Singapore Dollar
SKK Slovak Koruna
SIT Slovene Tolar
SOS Somali Shilling
ZAR South African Rand
KRW South Korean Won
ESP Spanish Peseta (Euro)
LKR Sri Lanka Rupee
SEK Swedish Krona
CHF Swiss franc
SYP Syrian Pound
TZS Tanzanian Shilling
THB Thai Baht
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Table 3-1. Available currencies in Mercury IT Governance Center (page 5 of

5)
Currency Code Currency Name
TOP Tunisian Dinar
TRL Turkish Lira
UAH Ukrainian Hryvnia
AED United Arab Emirates Dirham
uUSsD* United States Dollar*
VEB Venezuelan Bolivar
VND Viet Nam Dong
YER Yemeni Rial
ZWD Zimbabwe Dollar
* As all FX rates are based on United States Dollars, USD is
not actually selectable.

Adding anew currency makesit available to be displayed by any region. When
you add a new currency, you must also fill in FX rates for current and future
time periods.

To add anew currency:
1. Log on to Mercury IT Governance Center.

2. From the menu bar, select Cost > Exchange Rates > Manage Financial
Exchange Rates.

The Manage Financial Exchange Rates page opens.
3. Click Add a Currency.

The Add Currency page opens.
4. From the Select Currency to Add auto-complete list, select a currency.
5. Enter an Exchange Rate for all Effective Dates listed.

6. Click Add.
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Adding a New FX Rate

When you add anew FX rate, all cost data (budget values, project plan costs,
and so forth) are re-calculated relative to the base currency.

To add anew FX rate:

1.

2.

Log on to Mercury IT Governance Center.

From the menu bar, select Cost > Exchange Rates > Manage Financial
Exchange Rates.

The Manage Financial Exchange Rates page opens.

. Click Add New FX Rate.

The Add Financial Exchange Rate page opens, with current FX rate values
for al active currencies defaulted.

. From Effective Date, select a date for the new FX rate to take effect.
. Enter the new FX rate for the desired currencies listed.

. Click Add.

Editing Existing FX Rates

To edit existing FX rates:

.1

2.

. Log on to Mercury IT Governance Center.

From the menu bar, select Cost > Exchange Rates > Manage Financial
Exchange Rates.

The Manage Financial Exchange Rates page opens.

. Click the Edit Rates link under the time period you wish to edit.

The Edit Financial Exchange Rate page opens.

. Edit the FX rate values for the desired currencies.

. Click Done.
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Managing Regions (Handling Currency Display)

Currency display is based on region. A single region’s definition includes both
itslocal currency and regional calendar.

Regional calendars are used primarily by the Mercury Project and Resource
@: Management functionality. For more information on regional calendars and their

usage, see the Mercury Resource Management User’s Guide.

Depending on what region an entity is associated with, a different local
currency may be used to display its cost data. The following entities can have
regions specified:

e Project plans

e Project templates
e Resources

e Organization units
e Skills

e Budgets

e Financia benefits

Creating Regions
To create anew region:
1. Log on to Mercury IT Governance Center.
2. From the menu bar, select Administration > Regions > Create Region.
The Create a New Region page opens.
3. Enter aRegion Name and specify the Regional Calendar and Local Currency.
4. Select Yes to enable the region.

5. Click Create.
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Modifying Existing Regions
Y ou can modify existing regions through the Modify Region page.

The Modify Region page also enables you to disable aregion for further use.
Entities that currently use the region will be unaffected, but it will not be
available as a selection for new or existing entities going forward.

To modify existing regions:
1. Log on to the Mercury IT Governance Center.
2. From the menu bar, select Administration > Regions > Manage Regions.
The Manage Regions page opens.
3. Click on the desired Region Name.
The Modify Region page opens.
4. Make the desired changes.

5. Click Done.

Associating Regions with Entities

Regions are associated with various Mercury IT Governance Center entities
from particular locations. Table 3-2 identifies the locations from which to
specify aregion for each entity.

Resources can either inherit their regions from the primary organization units
they belong to, or they can have a region specified directly. Resources that do
not belong to a primary organization unit are assigned a region from the
Change Resource Settings page. For more information on resources and regions,
see the Mer cury Resour ce Management User’ s Guide.
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Table 3-2. Locations of region selection fields on entities

Entity

Location

Field

Projects and

(Region is selected only upon creation)

Project ) ) Project Region
Templates New Project window
Standard interface > Create a New Budget .
Select Region
page
Budgets
Standard interface > Budget page > :
Change Properties for Budget page Select Region
. . Standard interface > Create a New Select Region
Financial Financial Benefit page 9
Benefits
Standard interface > Financial Benefit page | Select Region
. Resource will:
Resources Standard interface > Resource page > e Inherit Region ..

Modify Resource page

e Use this Region

Organization
Units

Standard interface > Create a New
Organization Unit page

Parent Org Unit

e Inherit Region
from Parent

e Use this Region

Standard interface > Organization Unit
page > Modify Organization Unit page

Parent Org Unit

e Inherit Region
from Parent

e Use this Region

Standard interface > Create a New Skill
page

Regional Cost Rate

Skills
Stgndard interface > Skill page > Modify Regional Cost Rate
Skill page

Time

Management , .

Charge Code Workbehch > Time Mgmt screen > Override Regional Cost Rate

. Rules window
Override
Rules
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Viewing Regional Associations
The View Region Usage page, accessible from aregion’s Modify Region page,
displaysalist of al the entities linked to that region. Organization units and

resources that specify the region directly are displayed; those that merely
inherit the region are not.

To view aregion’s usage:
1. Log onto Mercury IT Governance Center.
2. From the menu bar, select Administration > Regions > Manage Regions.
The Manage Regions page opens.
3. Click on the desired region name.
The View or Modify Region page opens.
4. Click Vview Usage.

The View Region Usage page opens.

Managing Regions (Handling Currency Display) 37



Chapter 3: Managing Financial Exchange Rates and Currencies

Setting Your Personal Currency Display Preference

Y ou can choose the currency to display in all of your Mercury IT Governance
Dashboard™ pages and portlets.

To select your preferred currency:
1. Log onto the Mercury IT Governance Center.
2. From the menu bar, select Settings > Edit My Profile.
The Edit My Profile page opens.
3. Select an option in the Cost Display section of the page.

4. Click Done.
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Overview of Tracking and Analyzing Financial Data

While the Mercury IT Governance Center’ s Financial Management
capabilities allow you to track planning-related cost data in the form of
budgets, you can also capture cost data during project plan executionin a
variety of ways. This cost data can then be compared to financial data recorded
in project or program budgets.

This chapter explains the different ways to capture actual cost data for projects
and programs, and how to analyze this data.

Cost Data Calculations and Formulas

Financial Management allows users to capture and track planned and actual
cost information for their project plans, giving visibility into project
performance from a financia standpoint. Basic cost information can be
captured on projects and tasks in the areas defined by Table 4-1.

Table 4-1. Cost data items and associated formulas

Item Definition Formula

Planned Labor Cost =
The cost of a work item (typically a task) which is a Sum of (Allocation *

Planned Labor measure of the amount of scheduled effort on a task. This | Resource Rate) for

Cost figure is task-specific and is rolled up to the Master Project. | each resource
assigned to the task
The cost of miscellaneous items needed to complete a
Planned Non- work item. This is not a direct measure of the effort to be Manually entered
Labor Cost spent on a work item. This figure is task-specific and is y
rolled up to the Master Project.
Planned Cost =
. Planned Labor t
Planned Cost The total planned cost represented by a work item. anned Labor Cost +

Planned Non-Labor
Cost

Baseline Labor Cost =
Planned Labor Cost at
time of Baseline

Baseline Labor The labor cost for a work item in the active baseline taken
Cost of a project.
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Table 4-1. Cost data items and associated formulas [continued]

Item

Definition

Formula

Baseline Non-
Labor Cost

The non-labor cost for a work item in the latest baseline
taken of a project.

Baseline Non-Labor
Cost = Planned Non-
Labor Cost at time of
Baseline

Baseline Cost

The total cost represented by the latest baseline taken of a
work item.

Baseline Cost =
Baseline Labor Cost +
Baseline Non-Labor
Cost

Actual Labor
Cost

The cost of the work performed on a work item.

Actual Labor Cost =
Sum of Actual Effort *
Resource Rate

Actual Non- The totgl of all miscellaneous costs accrued in completing Manually entered
Labor Cost a work item.

: : : : Actual Labor Cost +
Actual Cost The total cost incurred in completing a work item. Actual Non-Labor Cost
Skill Rate The hourly cost associated with a particular skill. Used Task Cost = Skill Rate

when a skill is assigned to a task in a project plan.

* Actual Effort

Resource Rate

The hourly cost associated with a particular resource.
Used when a resource is assigned to a task in a project
plan. Takes precedence over the rate of the skill assigned
to a task.

Task Cost = Resource
Rate * Actual Effort

Planned Value
(PV)

The portion of the Baseline Cost planned to be spent
between the project’s start date and the current date.

Baseline Cost *
((Today’s Date - Start
Date) / (Finish Date -
Start Date))

Earned Value
(EV)

The portion of the Baseline Cost for the entire project that
has theoretically been spent by the current date, measured
as a function of the amount of work performed thus far.

EV = Baseline Cost *
% Complete

Cost
Performance
Index (CPI)

The cost efficiency ratio of Earned Value to Actual Cost.

CPl is used to calculate Projected Actual Cost for a project.

CPIl = EV / Actual Cost
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Table 4-1. Cost data items and associated formulas [continued]

Iltem Definition Formula
Schedule The ratio of Earned Value to Planned Value. SPI describes
Performance what portion of the project plan has been accomplished in | SPI = EV/ PV
Index (SPI) terms of its cost.

Notes:

e All cost information utilizing a formula is calculated automatically by Project Management.
e Calculations for SPI use the expected baseline cost of a project and do not involve Actual Cost.

e Order of precedence for task cost calculation is as follows: Resource Rate is used first. If there is no
Resource Rate and no skill assigned to the task, the resource’s Primary Skill Rate is used. If the
resource has no primary skill, the Skill Rate associated with the task is used. Cost data is not
automatically calculated for a task with no skill and no resource assigned.

Configuring Cost in the Project Settings Window

If you want to track financial datain a project plan, you must configure its
Financial Management-rel ated settings first in the Project Settings window.

To open the Project Settings window, select Settings from the Project menu at
the top of the Mercury IT Governance Workbench.

£ Settings for Infrastructure Redevelopment

Project Team 1
Project Fields

MSP Synchronization I

Costand Effort

Exception Rules I

I Resource Management 1

Indicators I

Baselines

Scheduling I Security

Wiy

This tab configures the Project fields that can be displayed inthe "Plan® tab of the Project window, and also the Project and Task detal pages and My Task
portlet inths standard Mercury IT Governancs intertace. Changing the fisid configuration here does not change th display in the other tabs of the Froject

rPlanring Field
Manager
Use Only

Enabled Fields

1
-

Departisrt

Description

Priority

Skill

Activity

b i A i A e i e Ui i (i B i
T T i T T T S 1 i Ty i

Project/Task #
Resource Group

Scheduled Effart

rActivity Fisld

Enabled

<1

OO O e e e e e e e (m

Manager
Use Only

1

OO oooooobo oo

Fields:

% Complete

Actual Duration

Actusl Effort

Actual Finish Date

Actual Start Date:
Conficdence

Estimated Finish Date
Estimated Remaining Durstion

Estimated Remaining Effort

Cancel

\Ready

Figure 4-1. Project Fields tab of the Project Settings window
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The Project Settings window contains tabs controlling various aspects of a
project plan. Two tabs in particular focus on Financial M anagement:

e The Cost and Effort tab lets you configure how cost datais calculated on
the project/task level, and what level of manual entry is needed.

e The Security tab lets you control which users can see cost data for the

project.

Cost and Effort Tah

The Cost and Effort tab in the Project Settings window determines whether or
not financial dataistracked for a project plan, and how actuals are to be
calculated, if at al. The Cost and Effort tab also determines how Time
Management is used to track effort; for more information, see the Mercury
Resource Management User’s Guide.

£ Settings for Infrastructure Redevelopment

Froject Fields 1

Project Team 1

~

&

Thiz project has capitalizable costs.
Planned labar cost wil be:

Actual labor cost will be:

[

Exception Rules
MSP Synchranization

I™ Use Time Management to track actual effort against this project

e J2=]

& s tomatically calculated based on scheduled effort and rates.

" Marually entersd ontasks and rolled up to sub-projects and master projsct

& sutomatically calculated based on actual effort and rates:

" Manually ertered on tasks and rolled up to sub-projscts and master project

Security

Baselines

Indicatars I
Cost and Effort

Scheduling I

Resource Management

Apply Cancel

\Ready

Figure 4-2. Cost and Effort tab of the Project Settings window

Selecting the Enable Financial Management checkbox turns on Financial
Management. Y ou must then choose from the following options for the

tracking of cost data:
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® Planned labor cost will be:

Automatically calculated based on scheduled effort and rates. Planned
labor costs for tasks will be automatically calculated and rolled up to
projects. These values are not calculated until aresource or skill is
assigned to atask. For definitions of planned labor costs and how
Project Management cal culates them, see Table 4-1 on page 40.

Manually entered on tasks and rolled up to sub-projects and master
project. Planned labor costs for tasks will be entered by the Project
Manager or other user with the proper level of access. These values are
rolled up to projects automatically.

® Actual labor cost will be:

Automatically calculated based on actual effort and rates. Actual |abor
costs for tasks will be automatically calculated and rolled up to
projects. These values are not calculated until aresource or skill is
assigned to atask. For definitions of actual labor costs and how Project
Management calcul ates them, see Table 4-1 on page 40.

Automatically calculated by Time Management. Mercury Time
Management must be used to track effort for this to function properly.
Actua labor costsfor tasks will be automatically calculated from effort
tracked by time sheets entered in Time Management by users. For more
information on Time Management, see the Mercury Time Management
User’s Guide.

Manually entered on Tasks and rolled up to sub-projects and master
project. Actual labor costs for tasks will be entered by the Project
Manager or other user with the proper level of access. These values are
rolled up to projects automatically.
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Security Tab

The Security tab in the Project Settings window provides options for
determining which users are allowed to view cost data for a project.

£ Settings for Infrastructure Redevelopment

Project Team 1 MSP Synchronization I Costand Effort I Resource Management Baselines

Project Fields 1 Exception Rules I Indicators I Scheduling Security
This Projectand its Tasks can be viewed by
& Allusers

© Participant Restricted - Only users assigned as Project Managers, Resources, orin an assigned Resource Group

Caostinformation on the Project and Tasks can be viewed by
& Allusers

© Project Manager for this Master Project only
© Project Manager for Master Project Infrastructure Redevelopment and all of its subprojects
" Participants for anly the Tasks and Projects for which they are Participants.

© Project Team only.

Apply Cancel

\Ready

Figure 4-3. Security tab of the Project Settings window

Y ou can choose from the following options:

All users (default)

® Project Managers for this Master Project only

® Project Managers for this Master Project <Project Name> and all of its
Subprojects

® Participants for only the Tasks and Projects for which they are Participants

® Project Team only
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Configuring Actual Cost Data Calculation

Depending on the Cost and Effort tab settings in the Project Settings window,
actual labor costs can be entered manually for projects or tasks, or
automatically calculated. Select one of the following options:

e Automatically calculated based on effort. Actual labor costs for tasks will
be automatically calculated and rolled up to projects. These values are not
calculated until aresource or skill is assigned to atask. For definitions of
actual labor costs and how Project Management cal culates them, see
Table 4-1.

e Automatically calculated by Time Management. Actual |abor costsfor tasks
will be automatically calculated from time sheets entered in Time
Management by users. For more details on integration with Time
Management, see Rolling Up Task Cost from Time Sheets.

e Manually entered on Tasks and rolled up to sub-projects and master
project. Actual labor costs for tasks will be entered by the Project Manager
or other user with the proper level of access. These values arerolled up to
projects automatically.

Automatically Calculating Task Cost

Actual labor cost datais automatically calculated by Project Management as
follows:

Number of hours spent * Skill/Resource rate = Task cost

The values for tasks can then be rolled up to their parent projects.

Example: Developer Bob has a rate of $20/hour. He spends 4 hours on a
task in a bug-fixing project.

The task’s actual labor cost is computed as $20/hour * 4 hours = $80 for
the task.

The bug-fixing project has atotal of 5 tasksidentical to Bob’s. The Total
actual labor cost for the project comes to $400 with no actual non-labor
costs incurred.

Actua non-labor costs are not captured automatically, and can be entered
manually at any time.
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Example: Developer Bob needs to spend $100 on RAM to upgrade his
machine so he can finish one of histasks. Thisis entered as an actual non-
|abor cost.

Rolling Up Task Cost from Time Sheets

Actual labor cost data can be automatically updated by time sheets. This
requires installing Mercury Time Management and using time sheets to track
effort. For more information on Time Management, see the Mercury Time
Management User’ s Guide.

Actua non-labor costs are not captured automatically, and can be entered
manually at any time.

Manually Entering Actual Lahor Costs

Though actual labor costs can be calculated automatically, you may want to
manually enter values for tasks or subprojects. Actual labor costs can be
entered from any of the three following locations:

e Project window Cost tab
e Project window Plan tab
e Individual Project or Task Information window
Actua non-labor costs are not captured automatically, and can be entered
manually at any time.
Entering Cost Data in the Project Window - Cost Tab

Actual labor cost data can be entered in the Cost tab of the Project window.

Financial Management must be enabled from the Project Settings window’s Cost
Note and Effort tab in order for the Cost tab to be enabled.

To enter actual labor cost data in the Cost tab of the Project window:
1. Open the desired project plan in the Project Workbench.

2. Verify in the Project Settings window’ s Cost and Effort tab that you can
enter actual labor cost values for tasks or projects.
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The Actual labor cost will be option should be set to Manually entered on
tasks and rolled up to sub-projects and master project.

Upon verifying, click OK. The Project Settings window closes, returning
you to the Project window.

3. Click the Cost tab.

4. Enter the actual labor cost valuesin the appropriate task or project lines as
described in the Table 4-2 on page 48.

5. Save the changes.

Click save to save changesto the project plan and continue editing it. Click
OK to save changes to the project plan and close the Project window. Click
Cancel to close the project plan without saving any changes.

Table 4-2. Project Information window - Cost tab fields and controls

Field Description

Indicates cost health based on Cost Summary Condition

Project Cost Health .
settings.

Labor cost for the task or project in the latest Baseline of the

Baseline Labor .
project.

Non-Labor cost for the task or project in the latest Baseline

Baseline Non-Labor of the project.

Total cost planned for the task or project in the latest

Baseline Total Baseline of the project.

Dollar cost planned to be spent on the amount of scheduled

Planned Labor effort involved to complete the task or project.

Dollar cost planned to be spent on miscellaneous costs

Planned Non-Labor required to complete the task or project.

Planned Total Total dollar cost planned to be spent on the task or project.

Dollar cost of the effort performed on a task or project during

Actual Labor . . .
a given time period.

Dollar cost of the miscellaneous costs acquired in

Actual Non-Labor . .
completing a task or project.

Total dollar cost incurred in completing a task or project

Actual Total . . . :
during a given time period.

Budget Name of the project budget.
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Entering Cost Data in the Project Window - Plan Tah

To enter actual labor cost data in the Cost tab of the Project window:

1.

2.

Open the desired project plan in the Workbench.

Open the Project Settings window.

. In the Project Fields tab, enable the desired fields (Actual Labor, Actual

Non-Labor, Planned Labor, Planned Non-Labor).

. Verify in the Cost and Effort tab that you can enter actual labor cost values

for tasks or projects.

The Actual labor cost will be option should be set to Manually entered on tsks
and rolled up to sub-projects and master project.

Upon verifying, click OK. The Project Settings window closes, returning
you to the Project window.

. Click the Plan tab.
. Enter the actual labor cost values in the appropriate task or project lines.

. Save the changes.

Click save to save changesto the project plan and continue editing it. Click
OK to save changes to the project plan and close the Project window. Click
Cancel to close the project plan without saving any changes.

Entering Cost Data in the Project or Task Information Window

To enter actual labor cost data in the Cost tab of the Project Or Task Information
window:

1.

2.

Open the desired project plan in the Workbench.

Verify in the Project Settings window’ s Financial Management tab that you
can enter actual labor cost values for tasks or projects.

The Actual labor cost will be option should be set to Manually entered on tsks
and rolled up to sub-projects and master project.

Upon verifying, click OK. The Project Settings window closes, returning
you to the Project window.
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. Double-click the project or task you want to update.

The Project or Task Information window opens.

. Click the Cost tab.
. Enter the actual labor cost values in the appropriate task or project lines.

. Save changes to the project or task.

Click Apply to save changes to the project or task and continue editing it.
Click OK to save changesto the project or task and close the Project or Task
Information window.

. Save changes to the project plan.

Click save to save changes to the project and continue editing it. Click OK
to save changes to the project and close the Project window. Click Cancel to
close the project without saving any changes.
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Cost Rollup in Budgets for Project Plans

Actual cost datafor aproject plan can be automatically calculated or manually
entered; for more information, see Configuring Actual Cost Data Calculation.
This data can also be configured to roll up into the budget linked to that project
plan. This allows you to compare budget against project performance more
directly through budget-based visualizations and analyses.

Cost Rollup from Tasks

All tasks can be grouped according to the following categories:
e Labor/Non-Labor

e Capital/Operating (if capitalization tracking has been activated; see
Enabling SOP 98-1 Tracking on page 66 for details)

Budget lines are al so grouped according to the same categories. If abudget is
set to automatically roll up actuals from the project plan it is associated with,
the actual values appear as subtotals per category in the Actuals column for
each period in the budget. These values can be automatically calculated on the
project plan side, or manually entered into a project plan.

e All task costs classed as L abor are grouped and reported as a subtotal in the
budget’s Labor category.

e All task costs classed as Non-L abor are grouped and reported as a subtotal
in the budget’s Non-L abor category.

Clicking on a subtotal value for a category opens a drilldown page that shows
how the rolled-up data was cal culated from the project plan, as shown in
Figure 4-4.
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MERCURY

November 2004 Cost for Project: Infrastructure Redevelopment

Done

wigwing &l Tasks for November 2004 Grouped by Subproject

Display Costs in:  United States Dollar

Labor Project Budget Baseline Planned Value Actual Cost

Infrastructure Redevelopment

Energize Product Stream 30 30

Goals Cleared 30 30
Infrastructure Redevelopment = Align Targst Matrix

Clear Previous Project Cache 30 30

Reset Pattern Cycler 30 30
Infrastructure Redevelopment = Inftialize Development Cycle

Actuslize Potentials 30 $3,300

Hick-Start Synergy 50 $2,700

Reemphasize Goals 30 $2,100
Labor Total $11,000 $0 40 $8,100
Hon-Labor Project Budget Baseline Planned Value Actual Cost

Infrastructure Redevelopment

Energize Product Stream 30 30
Goals Cleared 30 30
Infrastructure Redevelopment = Align Targst Matrix
Clear Previous Project Cache $0 30
Reset Pattern Cycler 30 30
Infrastructure Redevelopment = Inftialize Development Cycle
Actualize Potentials 30 800
Hick-Start Synergy 50 3645
Reemphasize Goals 30 308
Hon-Labor Total $0 $0 $0 $1,953
Project Budget Baseline Planned Value Actual Cost
Total Cost for Project $11,000 $0 40 10,053

Done

Figure 4-4. Automatically calculated project budget actuals rolled up from
project plan

Depending on whether you have capitalization tracking activated, you may see
Note different categories for your budgets and project plans.

Table 4-3 liststhe fields that need to be set in order for aproject plan budget to
roll up values from the project plan.
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Table 4-3. Settings required for project plan budget rollup

Location Field Setting
Workbench > Project Mgmt
screen > Project window > Enable Financial
Selected

Project Settings window > Cost
and Effort tab

Management

Workbench > Project Mgmt
screen > Project window >
Project Settings window > Cost
and Effort tab

Actual labor cost will
be

Either:

Automatically calculated
based on effort

Manually entered on
tasks and rolled up to
sub-projects and master
project

Workbench > Project Mgmt
screen > Project window >

Project Settings window > Actual Effort Selected
Project Fields tab

Standard interface > Budget .

page > Change Association for Thisis a (drop-down Project

Budget page

list)

Standard interface > Budget
page > Change Association for
Budget page

Budget for
(auto-complete)

<Name of the project>

Standard interface > Budget
page > Change Association for
Budget page

Actuals are

Rolled up from Project
information
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Cost Rollup from Time Management

If you have installed Mercury Time Management, you can track effort using
time sheets, and configure the project plan to roll up actual cost values from
those time sheets. These values can in turn be rolled up to the project plan
budget if desired. For more information on Time Management, see the
Mercury Time Management User’s Guide.

Table 4-4 liststhe fields that need to be set in order for aproject plan budget to
roll up values from time sheets logged against the project plan.

Table 4-4. Settings required for project plan budget rollup with Time
Management

Location Field Setting

Workbench > Project window > . .

. . . Enable Financial
Project Settings window > Cost Management Selected
and Effort tab 9

Workbench > Project window >
Project Settings window > Cost
and Effort tab

Actual labor cost will | Automatically calculated
be by Time Management

Standard interface > Budget
page > Change Association for
Budget page

This is a (drop-down

lst) Project

Standard interface > Budget
page > Change Association for
Budget page

Budget for

(auto-complete) <Name of the project>

Standard interface > Budget
page > Change Association for | Actuals are
Budget page

Rolled up from Project
information
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Cost Rollup in Budgets for Programs

Cost datafor all the projectsthat make up a program can be rolled up from the
project budgets into the program’ s budget.

Project 1

Budget 1

Program

Budget
Project 2 Project 3
Budget 2 Budget 3

\:

Figure 4-5. Project plan budget lines rolled up to program budget lines

Actua valuesrolled up from project budgets appear as subtotalsin the
program budget’s Actuals columns. Clicking on a subtotal value for a category
opens adrill down page that shows how the rolled-up data was cal culated from
the projects, as shown in Figure 4-6.

Cost Rollup in Budgets for Programs
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MERCURY'

November 2004 Budget for Program: Global IT Ops Initiative
Done
Showing all Projects from Program - Global IT Ops Intiative Grouped By Lakor and Non-Lakor.
Display Costs in: United States Dollar
Capital Program Planned Project Planned Actuals
CRM System 6.7 “igw Budget $5,000 $8,062
WCH Project 2 “igw Burget $5,000 19,541
Capital Total $5,000 $10,000 $21,603
Operating Program Planned Project Planned Actuals
CRM System 6.7 “igw Burget 6,000 58,644
WCA Project 2 “igw Budgst 36,000 39,806
Operating Total $4,000 $12,000 18,530
Program Planned Project Planned Actuals
Total Cost for Program $9,000 422,000 446,133
Done

Figure 4-6. Automatically calculated program actuals rolled up from project
plan budgets

Depending on whether you have capitalization tracking activated, you may see
Note different categories for your program and project budgets.

In order for program budget rollup calculation to work properly, each project
plan in the program is required to have a budget attached.

Table 4-5liststhe fields that need to be set in order for a program budget to roll
up valuesfrom its project plans.

Table 4-5. Settings required for program budget rollup

Location Field Setting

Standard interface > Budget
page > Change Properties for
Budget page

This is a (drop-down

lst) Program

Standard interface > Budget
page > Change Properties for
Budget page

Budget for (auto-

complete) <Name of the program>

Standard interface > Budget
page > Change Properties for | Actuals are
Budget page

Automatically Rolled up
from project information
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Analyzing Project Costs

The Mercury IT Governance Center’s Financial Management capabilities
provide useful interfaces for visualizing project cost data. The primary
visualization tools are discussed below.

Project Cumulative Cost Metrics

The Analyze Cumulative Cost Metrics page can be reached by selecting Analyze >
Projects > Cumulative Cost Metrics from the Cost menu group in the menu bar.

Analyze Cumulative Cost Metrics for a Project

Currertly your Cumulative Cost Metrics Graph is fitered by: Project Name - Infrastructure Redeploymert, Feriod - Week, Firish Date - Dec 27, 2004

Projected Actual Costs ;  $45,530

Cost
Today
$60.000
i L) i Ll L

$50.000

$40,000

$30,000

$20.000 '

$10.000

L
|
s0 &
102604 110104 110804 11604 102204 112904 120604 121304 122004 1202704
Week
M Flanned Value (F\) Eamed Value (EV) W Actual Costs (ALY Budget @ Budget Actuals
= Projected Actual Costs
102504 110104 110804 114504 112204 1129004 1206004 121304 122004 122704

Planned Value $8440  FIGEO0  f24.325 2,047 $282 30 30 $0 30 $0
Hon-Labor $0 0 0 0 0 0 0 0 0
Budget Actuals $4,402 $4,402 $4,402 4,402 1,255 30 30 30 0
Labor 34,043 $4,043 54,049 34,043 1,157 0 50 30 50
Hon-Labor 352 352 3352 352 1M 30 30 30 30
Filter By Apply

Include in graph:

M Planned Value (FY)

Esrned Value (Ev)
M sctusl Costs (AC)
Burget

Figure 4-7. Analyze Cumulative Cost Metrics page

Analyzing Project Costs 57



Chapter 4: Tracking and Analyzing Financial Data

The Analyze Cumulative Cost Metrics page can be filtered according to the
criteria described in Table 4-6.

Table 4-6. Analyze Cumulative Cost Metrics page parameters

Field

Description

Project Name

The name of the project being analyzed.

The period to be used in the graph’s time axis. Possible

Period values: Week, Month, Year.
Start Date The date at which to start the graph.
Finish Date The date at which to end the graph.

Include in graph:

Planned Value (PV)

Graphs the portion of the Baseline Cost planned to be spent
between the project’s start date and each data point.

Earned Value (EV)

Graphs the portion of the Baseline Cost for the entire
project that has theoretically been spent by each data point.
(Baseline Cost * % Complete)

Actual Costs (AC)

Graphs the total dollar cost for the project. (Actual Labor
Cost + Actual Non-Labor Cost)

Budget

Graphs the budget for the project at each data point.

Budget Actuals

Graphs the budget actual values, if any have been entered,
at each data point.

Use the Analyze Cumulative Cost Metrics page to get alook at a project’s
performance in terms of different cost variables over time. The project’s
projected actual cost is also calculated by Project Management and displayed

at the top of the chart.

The server.conf parameter PENDING_COST_EV_UPDATE_SERVICE_
ENABLED must be set to TRUE in order for the Analyze Cumulative Cost Metrics
page to obtain and process data. If necessary, contact your Mercury IT Governance
Center system administrator.
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Project Current Cost Metrics

The Analyze Current Cost Metrics page can be reached by selecting Analyze >
Projects > Current Cost Metrics from the Cost menu group in the menu bar.

Analyze Current Cost Metrics for Projects

Currently your Current Cost Metrics Graph i fitered by: Project Manager John Smith, Show only master projects, Size of bubble indicstes Budget

Actuals
SPI
15
1
05
o .
o 05 1 15
CPI
Project Cost Health
@ Red QO vellow @ sreen O HotEnabled
Project Hame Cost  Project Manager Budget Budget Total Actual Cost At SPI CPI
Health Actuals Baseline Completion
Thamas ¥Wilcax;John $20,000 $12,284 18,496 $307100 006 006
CD& System 3 ] it
Oinrastructurs ™ lohn Smith;Martin $31,000 $18,884 $61,344 $48,836 061 123
Redeployment Gregnbaum
Oinfrastructurs 7] John Smith §36,000 $10,053 $3360 435,695 048 015
Redevelopment
DlssP nitistive ™ John Smith;Martin $32,000 $6,718 61,344 $134360 041 036
Greenbaum
CRM System £.7 John Smith; il Molan $35,000 P17 282 320,776 $82,205 042 026
Filter By Apply
O
(& Other Criteria
Department: i Program: [
Project Manager: Johin Smith &
Project State: 1 onnota
] completed within the last day(s)
[ cancelled within the last day(s)
Actual Costs exceeds Earned Value by: Planned Value exceeds Earned Value by:
CPl Less than: SPI Less than:
Budget Greater than: Baseline Costs Greater than:
Budget Actuals Greater than:
Show only master projects? (&) ves (Mo
Size of bubble indicates:
() Buciget
(@ Bucget Actuals
() Baseline Costs
() Projected Actusl Cost &t Completion
Apply

Figure 4-8. Analyze Current Cost Metrics page
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The Analyze Current Cost Metrics page can be filtered according to the criteria

described in Table 4-7.

Table 4-7. Analyze Current Cost Metrics page parameters

Field

Description

Project Name

Project Name

Select a project to be displayed.

Master Project and
Subproject

Select a Master Project and/or subproject to be displayed.

Other Criteria

Department

Select projects from a certain department to be displayed.

Project Manager

Select projects with a certain manager to be displayed.

Project State

Select projects of a certain state to be displayed.

Actual Costs exceed
Earned Value by

Select projects with a cost variance greater than a certain
amount to be displayed.

Planned Value
exceeds Earned
Value by

Select projects with a schedule variance greater than a
certain amount to be displayed.

CPI Less Than

Select projects with a CPI under a certain value to be
displayed.

SPI Less Than

Select projects with an SPI under a certain value to be
displayed.

Budget Greater Than

Select projects with a budget greater than a certain amount
to be displayed.

Baseline Costs
Greater Than

Select projects with baseline costs greater than a certain
amount to be displayed.

Budget Actuals
Greater Than

Select projects with budget actual values greater than a
certain amount to be displayed.

Show only master
projects?

Select only Master Projects to be displayed.

Size of bubble indicates

Budget

Bubbles representing projects will vary in size based on the
size of their associated budgets.

Budget Actuals

Bubbles representing projects will vary in size based on the
size of their actual budget values, if any have been entered.
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Table 4-7. Analyze Current Cost Metrics page parameters [continued]

Field Description

Bubbles representing projects will vary in size based on the

Baseli . . ;
aseline Costs size of their last baseline costs.

Projected Actual Cost | Bubbles representing projects will vary in size based on the
at Completion size of their projected actual cost at completion.

Use the Analyze Current Cost Metrics page to compare the sizes and cost health
of one or more projects.

Viewing the Earned Value Analysis for a Project

Use the EV Analysis tab in the Project window to view EV Analysisdatafor the
of the project. Table 4-8 definesthe fields on this tab.

All fields within the EV Analysis tab are read-only and cannot be edited. Values
Note within these fields are not propagated dynamically.

Flan cost  EVAnalsis| Baselines |
o Matne Cost Heafth | Actual Cost (AC) Planned Earned Cost Schedule CPl SR
‘alue (PY) | Walug (Ev) | Wariance ‘ariance

1 ECDA System 3 [ ] $18,555.00 $10,472.00 $1.74936| ($1053464)| (§8,72264) 014 017

2 [inject Marketing Strateg [] $3,210.00 $552.00 $414.00 (31416007 r$138.00) 0.23 075

3 aintain Corporate Accourts [m] $2,520 00 §1,560.00 000 (32520000 (§1,560.00) ] 0

4 =Stabilize Market Pipeling [ ] $7,434 00 §1,440.00 $624.00] ($3.810.00) ($816.00) 014 0.43

S [ Recalculate Sales Wector [ ] $2,244 .00 $480.00 14400 (F1 260000 ($336.00) 1N 0.3

8 [—Competitor Compensstion [ ] $2,646.00 $480.00 $18200] (§1,254 00) ($255.00) 013 04

i - PR Cortainmert [ ] $2,544 00 $450.00 $288.00] ($1,296.00) ($192.00) 018 08

g rgane Customer Satistaction [ ] §2,095.00 F711.36) (52768641 (31,354 641

0o $210.24

10 eparate Testing Groups [ ] $1,68000 $592.00 $21312 (F726.58) (§378.88) 023 0.36
11 [—adust PR Madulation [ ] $2,715.00 §500.00 $288.00] (5115200 (5312.00) 02 048
12 K Complete O $0.00 $320.00 $0.00 $0.00 (320,007 1 0
13 [nitiste Reminders O $0.00 §1,055.00 $0.00 000  (¥,053.00) 1 a
14 “—Secure 1t Funds u $0.00 $1,608.00 $0.00 $000| (§1,60800) 1 o
13 I—Unliqu\dma Holdings O $0.00 $1,605.00 $0.00 $0.00|  (§1,608.00) 1 g
16 [=—Project Maintenance O $0.00 $2128.00 $0.00 000 ($2,128.00) 1 a
17 '—Strenglhen Assets L $0.00 §1,040.00 $0.00 $000| (§1,04000) 1 a
18 | Template Retormulation O 30,00 $1,088.00 $0.,00 3000 ($1,088.00) 1 0
19 C#Product nstatiation Complete O $0.00 J0.00 $0.00 J0.00 $0.00 1 1

Figure 4-9. EV Analysis tab of the Project window
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Table 4-8. EV Analysis tab fields

Field Description
Seq Number of a subproject or task in the hierarchy.
Name Name of a task or project.
Cost Health Indicates cost health based on Cost Summary Condition settings.
Actual Cost Total dollar cost incurred in completing a task or project during a
(AC) given time period.

Planned Value
(PV)

Portion of the Baseline Cost, in the latest Baseline of the project
plan, that is planned to be spent on the project or task between
the start and status dates.

Earned Value
(EV)

Portion of the Baseline Cost planned for the entire project or task
that should have been spent on the status date for the current
percentage of work completed. This value is calculated by
multiplying Baseline Cost by % Complete (EV = BC * %
Complete).

Cost Variance
(CV)

Difference between the estimated cost and the actual cost for the
project or task during a given time period. This value is calculated
by subtracting Actual Cost from Earned Value (CV = EV - AC).

Schedule
Variance (SV)

Difference between the scheduled completion and the actual
completion of the project or task. This value is calculated by
subtracting Planned Value from Earned Value (SV = EV - PV).

Cost Performance Index. Cost efficiency ratio of Earned Value to
Actual Cost. Used to predict the magnitude of possible cost

CPI overrun. The value is calculated by dividing Earned Value by
Actual Cost (CPlI = EV / AC).
Schedule Performance Index. Schedule efficiency ratio of Earned
Value accomplished against Planned Value. Describes what

SPI portion of the planned schedule was actually accomplished. This

value is calculated by dividing Earned Value by Planned Value
(SPI=EV/PV).
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Analyzing Program Costs

Y ou can track cost datafor programs. Enabling cost tracking can be done when
first creating a program or modifying an existing program. See the Mercury
Program Management User’ s Guide for more detailed information on turning
on cost tracking.

Y ou can analyze cost data for programs by doing one of the following:

e Clicking the Cost tab in the Manage Programs page and clicking Analyze for
either Current or Cumulative Cost Metrics.

e Clicking the EV Analysis tab in the Manage Programs page.

e Selecting Cost > Programs > Current O Cumulative Cost Metrics from the
menu bar.

These analyses are identical to cost data analyses for projects. See Analyzing
Project Costs on page 57 for more information on cost visibility.
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Chapter

SOP 98-1 Compliance

In This Chapter:

e Overview of SOP 98-1 and Financial Management
e Enabling SOP 98-1 Tracking
= Enabling SOP 98-1 at the System Administration Level
= Enabling SOP 98-1 on Projects
= Enabling SOP 98-1 on Project Templates
= Enabling SOP 98-1 on Budgets
e Using Activitiesto Track Capitalized Costs
= Configuring Activities
» Associating Activities with Projects and Tasks
= Activity Inheritance Behavior
e Viewing Capital and Operating Expense Data in Projects
= Viewing Cost Data in the Dashboard
= Viewing Cost Data with Reports
e Viewing Capital and Operating Expense Data in Programs
s Program Cost Summary Portlet
= Manage Program Page
e Viewing Capital and Operating Expense Data in Your Portfolio
= Total Exposure Portlet
= Impairment Risks Portlet
= Capitalized Project Timelines Portlet
n Capitalized Project Breakdown
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Overview of SOP 98-1 and Financial Management

Statement of Position (SOP) 98-1 is a United States accounting standard that
addresses the capitalizable activities of software developed for internal use.
Specifically, SOP 98-1 establishes the conditions that must be met before
internal-use software can be capitalized. The Mercury IT Governance Center’s
Financial Management capabilities can help optimize project planning and
execution for SOP 98-1 compliance in the following ways:

e Projects and tasks can be designated as Capitalizable, meaning costs
incurred during these phases can be accounted as Capital costs. This
distinction is also available for project templates, meaning you can create
repeatable projects with capitalization built-in.

e (Capital and Operating expenses can be viewed at the project, program, or
portfolio level, and analyzed accordingly.

If SOP 98-1 tracking is not turned on, cost data will not be split into Capital and
Operating categories.

Enabling SOP 98-1 Tracking

In order to track capitalized expense information, SOP 98-1 tracking must first
be activated in the following places:

e Atthe Mercury IT Governance system administration level
e Onaparticular project or project template
e On abudget

SOP 98-1 tracking cannot be activated for a project or project template without
first being enabled at the system level.
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Enabling SOP 98-1 at the System Administration Level

When installing or upgrading to Release 6.0 of the Mercury IT Governance
Center, you can decide whether or not to turn on SOP 98-1 tracking. SOP 98-1
tracking is enabled by setting the cosT CAPITALIZATION ENABLED parameter
inthe server.conf fileto True.

Usually, only Mercury IT Governance Center system administrators have access to
the Mercury IT Governance Center server. Contact your system administrator with
any questions about enabling SOP 98-1 tracking.

Enabling SOP 98-1 on Projects

SOP 98-1 tracking is set when you create or copy a project.
To enable SOP 98-1 tracking for a project:

1. Log onto Mercury IT Governance Center and open the Workbench.
2. From the shortcut bar, select Project Mgmt > Projects.

3. In the Project Workbench window, click New Project.

4. Enter the Master Project Name and Project Manager.

5. For the Project has capitalized costs? option, select Yes.

6. Click OK.

A new project is created that will be able to track capitalizable expenses.

If it is not already enabled, SOP 98-1 tracking cannot be activated for an existing
project.
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Enabling SOP 98-1 on Project Templates

SOP 98-1 tracking is set when you create a project template.
To enable SOP 98-1 tracking for a project template:

1. Log onto Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Mgmt > Project Templates Screen
group.

3. In the Project Template Workbench window, click New Project Template.
4. Enter the Project Template Name.

5. For the Project has capitalized costs? option, select Yes.

6. Click OK.

A new project template is created that will be able to track capitalizable

EXPEenses.
If it is not already enabled, SOP 98-1 tracking cannot be activated for an existing
Note project template.

Enabling SOP 98-1 on Budgets

SOP 98-1 tracking is set when you create a budget. On the Create New Budget
page, select Yes for the Wil this Budget have capitalized Costs? option.

For more detailed information on creating a budget, see Creating Budgets
on page 16.

Y ou can enable or disable SOP 98-1 tracking for abudget at any time through
the Change Properties for Budget page. For information on the Change Properties
for Budget page, see Setting Budget Associations on page 19.
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Using Activities to Track Capitalized Costs

Activities are a simple configuration entity for projects and tasks that can be
marked as capitalized. A project or task isidentified as capitalized when it is
associated with a capitalized activity. Activities can be used even when SOP
98-1 functionality is not enabled, but they cannot be marked as capitalized, nor
will projects or tasks associated with any activities track capitalization data.

Activities can also be associated with requests and packages, but cannot be
capitalized.

Configuring Activities
Activities are created, edited, and deleted in the Activities screen, accessible

from the Configuration screen group in the Workbench. Table 5-1 lists the
access grants needed to view or configure activities.

Table 5-1. Access grants needed to configure activities

Access Grant Permitted Actions

Config: View Activities User can view activities but not create, edit, or

delete them.
Config: Manage Activities User can create, edit, or delete activities.
Activity 1 [=] F3
Activity Marne: ||
Description: |
Enabled: & Yes " Mo
Can Be Capitalized? «
S0P 98-1 Category: =1
Use For
[~ Reguests [™ Projects and Task
[~ Packages [ Mist
oK | Save | Cancel
[Reacy
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Figure 5-1. Activity window

Table 5-2. Activity window fields and descriptions

Field

Description

Activity Name

The name of the activity (appears in field selections).

Description

A description for the activity.

Enabled

Whether or not the activity is enabled. Disabled activities do
not appear as selections.

Can be capitalized?

Indicates whether the activity can be capitalized. This field
is only active when tasks or projects have been selected
in the Use For list, and SOP 98-1 tracking has been
enabled system-wide.

SOP 98-1 Category

Specifies the SOP 98-1 category the activity falls under.
This field is only active when tasks or projects have been
selected in the Use For list, and SOP 98-1 tracking has
been enabled system-wide.

Use Activity For

Indicates the entities the activity can be associated with. All
activities enabled for a particular entity appear on time
sheet lines for that type of work item. See the Mercury Time
Management User’s Guide for more details on time sheets
and work items.

Creating Activities

To create an activity for use with SOP 98-1:

1. Log onto Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Configuration > Activities.

The Activity Workbench opens.

3. In the Activity Workbench, click New Activity.

The Activity window opens.

4. Enter an Activity Name and, optionally, a Description.

5. For the Enabled option, select Yes.
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6.

7.

8.

For the Can Be Capitalized? option, select Yes or No.
If Yes, choose an SOP 98-1 Category from the drop-down list.
For the Use For option, select Projects and Task at & minimum.

Click OK.

Modifying Existing Activities

To modify an existing activity:

1.

2.

Log on to Mercury IT Governance Center and open the Workbench.
From the shortcut bar, select Configuration > Activities.

The Activity Workbench opens.

. In the Activity Workbench, click New Activity.

The Activity window opens.

. In the Activity Workbench’s Query tab, enter search criteriafor the desired

activity and click List.

The Activity Workbench’s Results tab opens, displaying the results of your
search.

. Double-click the desired activity.

The Activity window opens.

. Make the desired changes to the activity and click OK.
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Deleting Activities

To delete an activity:

1.

2.

Log on to Mercury IT Governance Center and open the Workbench.
From the shortcut bar, select Configuration > Activities.

The Activity Workbench opens.

. In the Activity Workbench, click New Activity.

The Activity window opens.

. In the Activity Workbench’s Query tab, enter search criteriafor the desired

activity and click List.

The Activity Workbench’s Results tab opens, displaying the results of your
search.

. Select the desired activity and click Delete.

A confirmation dialog box appears, asking if you are sure you want to
delete the activity.

6. Click OK.

Only activities that are not in use can be deleted.

72

Mercury Financial Management™ User’s Guide



Chapter 5: SOP 98-1 Compliance

Associating Activities with Projects and Tasks

Assigning an activity to a project or task is done in the Project Or Task

Information window, opened from the Project Plan Panel in the Workbench.

To associate an activity with a project or task:

1.

2.

Log on to Mercury IT Governance Center and open the Workbench.

From the shortcut bar, select Project Mgmt > Projects.

. Open the desired project plan.

. In the Plan tab, double-click the desired project or task.

The Project or Task Information window opens.

. In the Project or Task Information window’ s Details tab, select an Activity

from the auto-complete list.

. Click oK.

Using Activities to Track Capitalized Costs
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Activity Inheritance Behavior

Tasks and subprojects can inherit their activity settings from their parent
projects, making it unnecessary to manually set the activity for every task and
subproject within a project. Activity inheritance follows certain rules:

e When an activity is set on a project, the same activity cascades down to all
its children. These children will continue to inherit whatever their parent’s
activity setting is. If one of these children is moved to a different parent
with a different activity setting, the child will acquire the new parent’s
activity setting.

e When achild with a different activity setting than its parent is found, the
activity setting cascade stops and that child’ s activity setting is preserved.
This child s activity setting will be preserved even if the child isindented,
outdented, or cut-and-pasted under a different parent.

e Inthecase of achildwith adifferent activity setting, manually setting that
child’s activity setting to that of its parent means that its activity setting
will no longer be preserved, and will become that of its current parent.

e Manually setting achild’ sactivity to an empty valuewill keep it empty, but
it will not stay empty if the child is moved to a parent with a non-empty
activity setting.

e |f asubproject’s parent changesits activity setting, the new activity will be
applied to the subproject and al its children as well, unless the subproject’s
activity setting is different than its parent’s, in which case the subproject
and its children will remain untouched.
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Viewing Capital and Operating Expense Data in Projects

Y ou can view the breakdown between capital and operating expenseson a
project in the Dashboard through particular portlets and pages, or by running
reports.

Viewing Cost Data in the Dashhoard

Capital and operating expense data can be viewed on the project level through
aportlet in the Project Overview page, or at the task level in the Task Detail page.
The cost data displayed can come from one of the following possible sources:

e The project budget, if one exists
e Cost data calculated from the project itself

Project Cost Summary Section

The Project Cost Summary section is found on a project’ s Project Overview
page. It displays cost datain Capital and Operating categories. Each category
is then broken down into Labor and Non-L abor.

Project Cost Summary
Project Cost Health: Costs from Budget: CREM Adjustments

Cost Overview

Capital Planned Actual
Lahor 12,000 6 437
Mon-Lakbor $&,000 1 B25
Total $20,000 $8,062
Operating Planned Actual
Lakor $6,000 $7.932
Mon-Lakbor 9,000 1,285
Total 15,000 $9,220
Project Total 35,000  $17,282

Earned Value Summary

Planned Value: §10,599 Sched Variance: (56,329
Earned Value: 4574 Cost Varlance: CF12,708)
Actual Cost: §17 282 SPL: 042 CPL: 026
Eamed ¥alue Details

Figure 5-2. Project Cost Summary section

The Project Overview page for aproject can be reached by searching for a
project or drilling down from a portlet in Mercury Project Management.
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Task Detail Page

A task’s Task Detail page contains a Cost Details section that displaysthetask’s
cost data and breaks the task cost into Labor and Non-Labor. The top of the
Task Detail page indicates the task’ s Activity.

Task Details

Save Reset

Task NHame: Lower Pipeline
Caonfiguration

Task State: |In Progress | &

Activity: Energize D3P Analysis Resource: | Timicox; Mindy Gr| || B
Project Path: Infrastructure Redeployment = Syrthesize Consensus » Lower Pipefine Configuration

Expand Al Coullapse All

# Exceptions (1 Exception Exists)

Progress

‘% Complete: |53

Start Date Finish Date Duration Effort
Scheduled:  November 5, 2004 Scheduled:  November 11,2004 Scheduled: 50 days
Actual: 54.0| haurs

=l Details

Skill : External Systems Ex| B5|  Resource:  TimWilcox; Mindy Gree...

# Predecessors

El Cost Details (Cost Health: E1)

Display Costs in: United States Dollar

Cost Overview

Planned Actual

Lakor 8,080 3,636

Mon-Lahar $0.00 $675.00

Total $8,080.00 $4,311.00

# Action ltems

# Notes

# References

Figure 5-3. Task Detail page

Save Reset

The Task Detail page for any task can be reached through the My Tasks portlet,
searching for atask, or drilling down from the Project Hierarchy portlet or

page.
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Viewing Cost Data with Reports
There are two Project Management reports that present cost information for
projectsin aclean and easy-to-read format for personal perusal or presentation.
Project Cost Breakdown Report

The Project Cost Breakdown report displays a breakdown of total Capital and
Operating expenses for a given project during a particular time period.

Print

Project Cost Breakdown

Mercury ; Run by John Smith, On Mov 1, 2004 04:48:20 FM PST

This Report shaws the costs for the Project and the Activities uith which the
casts are ass bor costs are the totals,

c
aciated, Labar and NMon-Labor costs are included in the tof

s for Report #30272
e - WCB Project 2, Time Period - Project to Date

Cost Breakdown Details for Project to Date

Activity CapEx Effort  CapEx Cost OpEx Effort  DpEx Cost
Adjust Trand Sampling 76 hrs $6272

Energize OSP Analysis 27 hrs $2190
Cperate CPD Process 25 hrs $2064

Realign Goals 15 hrs $1485
Retune CSD Core 45 hrs $3324
Target Strateqic Assets 31 hrs $2106

Totals: 122 hrs 49863 97 hrs $7578

Effort Cost
Grand Total: 219 brs 317441

Project Cast Breakdoun

Figure 5-4. Project Cost Breakdown report

See the Reports Guide and Reference for information on running reportsin
Mercury Project Management.

Project Cost Details Report

The Project Cost Details report displays the cost data for a given project or set
of projects, viewed by project hierarchy and broken down into Capital and
Operating expenses. Cost datais further broken down into Planned and Actual
columns. Y ou can choose not to view Capital/Operating, and see Labor/
Non-Labor valuesinstead.
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Print

. « Mercury ¢ Run by John Smith, On Moy 1, 2004 0450012 PM PST
Project Cost Details

Wiew Cost Details for a Project

Report Parameters
Filter By: Project Mame - WCB Project 2
Include: Capital Costs, Local Currency

Showing 1 Total Prejects; Grdered by - Praject Mame

Cost Details for WCE Project2 (Project Health = Green)

Project Name: WCB Project 2 (Scheduled Health = Green ) Project State: Active

%% Complete: & Project Manager: Thormas Wilcox
Scheduled Start Date: 10/27/04 Scheduled Finish Date: 11/5/04
Budget: $32000 Budget Actuals: $32000
Department:

Description:

Breakdown by Project and Tasks

CapEx DpEx Total

Seq  Project Name Planned  Actual Planned Actual Planned Actual
1 WCE Project 2 10776 $9863 £7720 37578 18496 17441
2 Tnject Marketing Strateqy $552 $1485 £0 40 4552 41485
3 Maintain Corporate Accounts 1560 $245 0 $0 $1560 $245
4 Stabilize Market Pipeline £1920 $2106 £2400 $5388 $4320  $7494
5 Recalculate Sales VYector £0 $0 960 $2064 $960 2084
3 Competitor Compensation £1920 $2106 0 40 41920  $2108
7 PR Centainment £0 $0 1440 33324 1440 $3324
2 Engage Customer Satisfaction 2936 $e027 £2120 $2190 45056 48217
9 Redeploy Recruiting Assocs $1752 33237 $0 $0 $1752  $3237
10 Separate Testing Groups 1124 $2790 0 40 1124 $2790
11 adiust PR Maodulation %0 %0 $1800 32190 f$1800  $2190
12 Engagement Complete £0 £0 £220 40 4220 40
13 Initiate Reminders $z178 $0 $0 $0 $2176 $0
14 Secure Management Funds £0 £0 f1608 40 $1608 40
15 Unliquidate Holdings $0 $0 $1608 $0 $1608 $0
16 Project Maintenance 1632 £0 $1592 40 $2224 $0
17 Strengthen Assets $0 $0 $1040 $0 $1040 $0
12 Template Reformulation 1632 £0 0 40 f1632 $0
19 Product Instatiation Complete $0 $0 $552 $0 $552 $0

Project Cost Details

Figure 5-5. Project Cost Details report

See the Reports Guide and Reference for information on running reportsin
Mercury Project Management.
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Viewing Capital and Operating Expense Data in Programs

Users of Mercury Program Management can use SOP 98-1 functionality to
view the breakdown between capital and operating expenses on a program in
the Dashboard through the Program Cost Summary portlet or on the Manage
Program page. The cost data displayed can come from one of the following

possible sources:

e The program budget, if one exists

e Cost datarolled up from the program’ s constituent projects

Program Cost Summary Portlet

The Program Cost Summary portlet displays cost datain Capital and Operating
categories. Each category is then broken down into Labor and Non-Labor.

Program Cost Summary

Cost Overview
Capital

Lakar

Mon-Labar

Total

Operating
Lakar
Mon-Lakar
Total

Program Total

Earned Value Summary

F26,077
13,080
$53,581

Eamed ¥alue Details

Planned Value:
Earned Value:
Actual Cost:

[Edit
Program Cost Health: O costsfrom Budget: Global IT Operations

Planned
F0
18,000

Actual

§0
§0

$18,000 $o

Planned  Actual

F15,000 o

0 o

18,000 1]

$36.000 $0
Sched Variance: (H12,996)
Cost Variance: (5408013

SPI: 0.0 CPI: 0.24

Figure 5-6. Program Cost Summary portlet

The Program Cost Summary portlet can be added to your Dashboard in the
usual way. For more detailed information on adding portlets to your

Dashboard, see the Getting Started guide.
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Manage Program Page

The Manage Program page contains a Cost tab. The Costing Information section
of the Cost tab displays the program’ s planned and actual total capital and
operating expenses, broken down by labor and non-labor. The Breakdown by
Project section displays similar categories of information, broken down by the
program’sindividual project plans.

Details | Cost || EV Analysis
Costing Information

Program Cost Health

Cost Overview

Capital Planned Actual Operating Planned Actual
Lator 0 $20033 Labor $12,000 §19,197
Mon-Labor 15,000 53,010 Non-Labor 50 52541
Total $16,000 $32,003 Total 12,000 21,838
Program Total $28,000 $53,881

5 Breakdown By Project

Planned Actual

Project Hame Cost Health Capital Operating Total Capital Operating Total
CRM System 6.7 [ ] 520,000 §15000 | §35000 38,062 §9.220 17282
B Project 2 18,000 $20000 | $35,000 23,361 §12618 | $36,599
Program Totals:  $38,000 $35000 | §$73,000 $32,043 $21,838 | $53,801

Figure 5-7. Manage Program page Cost tab

The Manage Program page for a program can be found by searching for a
program or drilling down from aportlet in Mercury Program Management.
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Viewing Capital and Operating Expense Data in Your
Portfolio

Users of Mercury Portfolio Management can use SOP 98-1 functionality to
view their capital exposure (the total amount of capital expense to date for all
currently open projects) using the Capital Exposure Dashboard page. The
Capital Exposure Dashboard page is pre-configured Dashboard content
delivered with Mercury Portfolio Management that becomes available for use
once SOP 98-1 tracking has been enabled.

The Capital Exposure Dashboard page may need to be distributed before it can be
@: added to your Dashboard. See the Configuring the Standard Interface document for

more detailed information.

For more information on pre-configured Dashboard content and how to add it
to your Dashboard, see the Getting Started guide.

The Capital Exposure Dashboard page features four portlets designed to
display and highlight capital exposure information for your portfolio.
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Front Page Forfolio Manager Capital Exposure Program Manager

Dashboard: Capital Exposure Personalize

Page last refreshed:Nov 18, 2004 03:21:36 FM GMT-02.00

Total Exposure Impairment Risks
Project Health Project Name
17% [ wes Projest2
_— [ infiastucture Reconfiguration
13%
3 27%
Carrying Value
Carrying Value
Capitalized Project Timelines
Name | 2008 [20u5
Fag [Sep Toet THow [Dec. |Jan [Feb Tl

CDA System 3 [— _ ]

CRMM Systeim 6.7

Infiastiucture Reconfiguration

Dei
E Pioject 2

Showing 1ta 5 of &  Maximize

Capitalized Project Breakdown
Project Hame & Project Manager Risk Carrying Total Planned
Value Planned | Cost
Capital
[=] CD& System 3 Thomas Wilcox 17 $2,902.00 $9,000.00 $20,000.00
] CRM System 6.7 Bill Molan 14 $8,062.00 $20,00000  $35,00000
[m] Infrastructure Reconfiguration Martin Greenbaum ) $8,665.00 $14,00000  $31,000.00
B SalesDemo a F0.00 F0.00 $35,000.00
O  wos Project 2 Thomas Wilcox 28 $23981.00  $18,00000 $38000.00
Showing 1to 5of 5 Prev Next Maximize:

Figure 5-8. Capital Exposure Dashboard Page

Total Exposure Portlet

The Total Exposure portlet displays apie chart of all the projectsin your
portfolio with capital expenses, diced by Project Health.
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Total Exposure

Froject Health

TO%

Carrying %alue

EAE

. Red
. Green
|:| ellow

Figure 5-9. Total Exposure portlet

This portlet can be filtered according to the criteria described in Table 5-3.

Table 5-3. Total Exposure portlet filter fields

Field

Description

Project Name

Filters for the specified project(s).

Project Manager

Filters for projects with the specified manager(s).

Business Objective

Filters for projects with the specified business objective(s).

Project Status

Filters for projects with the specified status(es).

Project Health

Filters for projects with the specified health(s).

Start Date From

Filters for projects starting after the specified date.

Start Date To

Filters for projects starting before the specified date.

Complete Date From

Filters for projects finishing after the specified date.

Complete Date To

Filters for projects finishing before the specified date.

Min Planned Capital

Filters for projects with at least the specified minimum
planned capital expenses.

Min Carrying Value

Filters for projects with at least the specified minimum
actual capital expenses.

Min Planned Cost

Filters for projects with at least the specified minimum
planned cost.

Min Actual Cost

Filters for projects with at least the specified minimum
actual cost.
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Impairment Risks Portlet

The Impairment Risks portlet is apie chart that drills down from any one of the
pieslicesin the Total Exposure portlet. The Impairment Risks portlet’s pie
dices correspond to the capital expenses of each project that makes up the slice

selected from the Total Exposure portlet.

Impairment Risks

Froject Name

Carrying “alue

EOE

[ wee Project2
I:‘ Infrastructure Reconfiguration

27%

Figure 5-10. Impairment Risks portlet

This portlet can be filtered according to the criteria described in Table 5-4.

Table 5-4. Impairment Risks portlet filter fields

Field

Description

Project Name

Filters for the specified project(s).

Project Manager

Filters for projects with the specified manager(s).

Business Objective

Filters for projects with the specified business objective(s).

Project Status

Filters for projects with the specified status(es).

Project Health

Filters for projects with the specified health(s).

Start Date From

Filters for projects starting after the specified date.

Start Date To

Filters for projects starting before the specified date.

Complete Date From

Filters for projects finishing after the specified date.

Complete Date To

Filters for projects finishing before the specified date.

Min Planned Capital

Filters for projects with at least the specified minimum
planned capital expenses.
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Table 5-4. Impairment Risks portlet filter fields [continued]

Field Description

Filters for projects with at least the specified minimum

Min Carrying Value actual capital expenses.

Filters for projects with at least the specified minimum

Min Planned Cost
planned cost.

Filters for projects with at least the specified minimum

Min Actual Cost
actual cost.

Capitalized Project Timelines Portlet

The Capitalized Project Timelines portlet displays a Gantt chart showing the
timelines of all capitalized projectsin the portfolio by default.

Capitalized Project Timelines [Edit
Name | 2004 [2005
| g [sep [oct [how [Dec |dan [Feb Thtar

e

Showing 110 5 of 5 Maximize

Figure 5-11. Capitalized Project Timelines portlet

This portlet can be filtered according to the criteria described in Table 5-5.

Table 5-5. Capitalized Project Timelines portlet filter fields

Field Description
Project Name Filters for the specified project(s).
Project Manager Filters for projects with the specified manager(s).
Business Objective Filters for projects with the specified business objective(s).
Project Status Filters for projects with the specified status(es).
Project Health Filters for projects with the specified health(s).
Start Date From Filters for projects starting after the specified date.
Start Date To Filters for projects starting before the specified date.
Complete Date From | Filters for projects finishing after the specified date.
Complete Date To Filters for projects finishing before the specified date.
Min Planned Capital Eligi:]sego(r:grr)ci)tjaelc;ir\;\/eitnhszé.Ieast the specified minimum
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Table 5-5. Capitalized Project Timelines portlet filter fields [continued]

Field Description

Filters for projects with at least the specified minimum

Min Carrying Value actual capital expenses.

Filters for projects with at least the specified minimum

Min Planned Cost
planned cost.

Filters for projects with at least the specified minimum

Min Actual Cost
actual cost.

Capitalized Project Breakdown

The Capitalized Project Breakdown portlet shows the capitalization
information for all capitalized projects in the portfolio by default. The
Remaining Capital Expenses column is calculated as follows:

Planned Capital Expenses - Carrying Value = Remaining Capital Expenses

Capitalized Project Breakdown
Project Hame & Project Manager Risk Carrying | Total Blanned
Value Planned | Cost
Capital
CDA System 3 Thamas Wilcax 17 $0.00 $9,000.00  $20,000.00
B CRMSystem67 Bill Molary 14 $6,06200 $20,000.00 3500000
O  infrastructurs Reconfiguration Martin Greenbaum a $6,66500  §14,00000 $31,000.00
] Sales Demo a $0.00 $0.00 $35,000.00
O  wceProject 2 Thamas Wilcax 28 $0.00 $18,00000  $36,000.00
Showing 1ta 5 of 5 Maximize:

Figure 5-12. Capitalized Project Breakdown portlet

This portlet can be filtered according to the criteria described in Table 5-6.

Table 5-6. Capitalized Project Breakdown portlet filter fields

Field Description
Project Name Filters for the specified project(s).
Project Manager Filters for projects with the specified manager(s).

Business Objective Filters for projects with the specified business objective(s).

Project Status Filters for projects with the specified status(es).
Project Health Filters for projects with the specified health(s).

Start Date From Filters for projects starting after the specified date.
Start Date To Filters for projects starting before the specified date.

Complete Date From | Filters for projects finishing after the specified date.
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Table 5-6. Capitalized Project Breakdown portlet filter fields [continued]

Field

Description

Complete Date To

Filters for projects finishing before the specified date.

Min Planned Capital

Filters for projects with at least the specified minimum
planned capital expenses.

Min Carrying Value

Filters for projects with at least the specified minimum
actual capital expenses.

Min Planned Cost

Filters for projects with at least the specified minimum
planned cost.

Min Actual Cost

Filters for projects with at least the specified minimum
actual cost.

Viewing Capital and Operating Expense Data in Your Portfolio
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Appendix

Financial Management Portlets

Information regarding Financial Management data can be organized and
presented using the Mercury Financial Management portlets. Mercury does not
supply a preconfigured Financial M anagement Dashboard page, except for the
Capital Exposure Dashboard page described in Viewing Capital and Operating
Expense Data in Your Portfolio on page 81. See Table A-1 for acomplete list
of the Financial Management portlets.
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Financial Management Portlets

Table A-1. Financial Management portlets

Financial Management
Portlets

Description

Capitalized Project Breakdown

Lists relevant information about capitalized
projects. Can be filtered so show the same
projects as the following portlets:

e Total Exposure
e Impairment Risks
e Capitalized Project Timelines

Capitalized Project Timelines

Graphical display of projects with capitalized
costs showing:

e Start date
e End date
e Health

Impairment Risks

Graphical display of active projects having
capitalized costs, chosen by project health and
broken out by project.

Project Cost Summary

Lists cost information for a program.

Program Cumulative Cost
Metrics

Trend chart analyzing the cumulative cost
metrics for a program. Line graphs indicate
historical values of important cost parameters.
Budget actuals include the total baseline planned
cost and the estimated actual cost at completion.

Program Current Cost Metrics

Bubble chart analysis of the current cost metrics
for a program. Analyzes the current cost metrics
for a program. Shows current cost status of a
project or current cost status of a program.
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Table A-1. Financial Management portlets [continued]

Financial Management
Portlets

Description

Project Budget and Staffing
Profile vs. Actuals

Compares budget and staffing profile plans to the
actual cost and resource usage of running
projects. Values are for the entire project to date.
Provides Dashboard-level oversight into the
status of a group of projects. Intended users are
PMO staff or external stakeholders.

Budgeted values for cost and hours are drawn
from a budget, not from a project baseline.
Actuals for costs are gathered from the budget.
Actuals for hours are aggregate from tasks
assignments and tasks actuals on the project
linked to the budget. Percent complete is also
drawn from the project actuals.

Project Cost Summary

List of cost information for a project.

Project Cumulative Cost Metrics

Trend chart analyzing the cumulative cost
metrics for a project. The trend chart contains
line graphs indicating historical values of
important cost parameters. Budget actuals
include the total baseline planned cost and the
estimated actual cost at completion.

Project Current Cost Metrics

Bubble chart analysis of the current cost metrics
for a project. Can be used to show current cost
status of a project or current cost status of a
program.

Total Exposure

Graphical view of active projects that have
capitalized costs grouped by the health of the
project.
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Appendix

Reports by Category

In This Appendix:

Overview of Report Categories
Administrative Reports

Change Management Reports
Demand Management Reports
Financial Management Reports
Portfolio Management Reports
Program Management Reports
Project Management Reports
Resource Management Reports
Time Management Reports
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Overview of Report Categories

Reports available through the Mercury IT Governance Center standard
interface are listed (by category) and described in the following sections.

Another type of report in Mercury IT Governance Center (not discussed in this

@: document) are server reports, which are submitted and viewed from the Workbench
interface, For information about server reports, see the System Administration Guide
and Reference.

Administrative Reports

The administrative reports (listed in Table B-1) are available to users with an
administration license.

Table B-1. Administrative reports

Report Definition

Provides an interface for checking whether Mercury
Contact Synchronization Demand Management contacts are properly defined.

This report is also in the Resource category.

Helps audit environment definitions when different
Environment Comparison environments (for example, development and production)
are similar to each other.

Lists the detailed definitions of a given environment or
group of environments, the major attributes of the
environments, and the attributes of applications tied to
the environments.

Environment Detalil

Contains detailed information about specified

Environment Group Detail .
environment groups.

Imports requests into Demand Management request
tables, moves the requests to the appropriate status, and
Import Requests reports on the results of the execution.

For more information about this report, see the Open
Interface Guide and Reference.
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Table B-1. Administrative reports [continued]

Report Definition

Imports data from the user interface tables or an LDAP
server.

For more information about this report, see the Open
Interface Guide and Reference.

Import Users

Lookup Types Provides information about one or more lookups.

Provides information about notifications that have been

Notification History sent or are pending

Lists all parameters and commands associated with a

Object Type Detail given object type.

Portlet Detail Provides information about a portlet or range of portlets.
Template of a report used to check files into the RCS
RCS Check In repository (if the RCS file management system is being
used).
Template of a report used to check files out of the RCS
RCS Check Out repository (if the RCS file management system is being
used).
Report Type Detail Provides information about report type definitions.

Lists detailed definitional information for request header

Request Header Type Detail types.

Request Type Detail Lists detailed definitional information for request types.

Runs field level security-related denormalization tasks for

Run Field Security Denormalization . o
particular entities.

Imports data from the organization unit interface tables or
an LDAP server.

For more information about this report, see the Open
Interface Guide and Reference.

Run ITG Organization Unit Interface

Validates and loads package data from the package open
interface tables into the standard Mercury Change

Run ITG Package Interface Management data model.

For more information about this report, see the Open
Interface Guide and Reference.

Validates and runs workflow transactions based on data
in the workflow open interface tables.

For more information about this report, see the Open
Interface Guide and Reference.

Run Workflow Transaction Interface

Lists definitional information for one or more security

Security Group Detail
groups.
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Table B-1. Administrative reports [continued]

Report Definition

Provides details for a command (special command) or a

Special Command Detail
range of commands.

Assesses or synchronizes the RML (Reporting Meta

Synchronize Meta Layer Layer).

Displays the definition of custom user data field (for
User Data Detail example, fields on entities like packages, requests,
workflows, and security groups).

Lists the users who have been defined in the Mercury IT
Governance system, as well as the security groups

User Detail attached to each user.
This report is also in the Resource category.
Provides information about the various custom
S validations that have been entered into the system as
Validations

well as those that are standard with Mercury IT
Governance Center products.

Provides detailed definitional information about specific

Workflow Detail workflows or sets of workflows.

Given a date range and a workflow (or a range of
Workflow Statistics workflows), this report provides statistical information
regarding workflow usage.

For More Information

Unless otherwise indicated in Table B-1, see the Reports Guide and Reference
for more information about Administrative reports.
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Change Management Reports

The Change Management reports (listed in Table B-2) are available to users
with a Mercury Change Management application license.

Table B-2. Change Management reports

Report Definition

Compare Custom Database Setup Runs custom database comparisons.

Compare Filesystem Environment Compares the files and file structures of two machines.
Compare MS SQL Server 7 Compares the data model of two SQL Server Version 7
Environments databases.

Compare Oracle Environments Compares the data model of two Oracle schemas.
Distribution Detail Lists the contents and results of a distribution.

Given two environments, this report looks at the history of
all the objects migrated into each environment (using
Mercury Change Management) and lists any differences.

Environment Comparison by Objects
Migrated

Lists objects that have been migrated into a given

Environments/Objects Detalil . .
environment or set of environments.

Provides a workflow step transaction history for

Object History packages

Lists objects that have been migrated into a given

Objects/Environments Detalil ) .
environment or a set of environments.

Package Details Returns details about a given package.

Package History Lists the complete workflow history of a given package.

Lists three separate sections for analysis:

e Other packages that contain common objects with a
given package

. ¢ Objects that have migrated alongside one or more of

Package Impact Analysis the objects being migrated on the given package but

are not included in the given package

¢ Recent migrations for each object in the package,
showing where changes to the given objects have
recently been deployed

Lists:

Pack Pendi ¢ Open packages with pending activity
ackages Pendin
g d e Details about each package

e Pending work for a group of users
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Table B-2. Change Management reports [continued]

Report Definition

Lists requests, packages and distributions associated

Release Detall ;
with a release.

Shows all of the requests and packages in a release as

Release Notes ; .
well as their associations.

For More Information

For more information about Change Management reports, see the Reports
Guide and Reference.
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Demand Management Reports

The Demand Management reports (listed in Table B-3) are available to users
with a Mercury Demand Management™ application license.

Table B-3. Demand Management reports

Report Definition

Queries the contacts already entered in the Demand
Contact Detail Management system that are available for entering and
updating requests.

Shows the history of demand creation for a specified

DEM Demand Creation History demand set

Shown the history of SLA violations for a specified

DEM Historical SLA Violation
demand set.

Shows the history of demand that has been satisfied for a

DEM Satisfied Demand History specified demand set

Provides information about requests using a number of

Request Detail . Y
selection criteria.

Request Detail (Filter by Custom Similar to the Request Detail report except that requests
Fields) can be filtered by values in custom fields.

Lists the complete workflow and field change history for

Request History each selected request.

Lists a quick summary of open and closed requests,

Request Quick View breaking down the requests by priority.

Displays the total counts for groups of requests matching

Request Summary the selection criteria.

Request Summary (Filter by Custom | Similar to the Request Summary report except that
Fields) requests can be filtered by values in custom fields.

Lists all open requests assigned to different users.

Resource Load by Priorit
y y This report is also in the Resource category.

For More Information

For more information about Demand Management reports, see the Reports
Guide and Reference.
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Financial Management Reports

The Financial Management reports (listed in Table B-4) are available to users
with a Mercury Time Management application license.

Table B-4. Financial Management reports

Report Definition

Summarizes actual time information entered in
non-cancelled time sheets and the calculated charge
dollar totals for each grouping.

This report is also in the Time Management category.

Actual Time/Cost Summary

Shows the costs for a project, and the activities with
Project Cost Breakdown which the costs are associated.

This report is also in the Project Management category.

Shows the cost details for select projects, grouped by
Project Cost Details labor/non-labor or operating categorizations.

This report is also in the Project Management category.

For More Information

For more information about Financial M anagement reports, see the Reports
Guide and Reference.
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Portfolio Management Reports

The Portfolio Management reports are available to users with a Mercury
Portfolio Management application license.

There are currently no Mercury-supplied reports in this category, but you can
create your own custom reports, if you like.

Program Management Reports

The Program Management reports are available to users with a Mercury
Program Management application license.

There are currently no Mercury-supplied reports in this category, but you can
create your own custom reports, if you like.
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Project Management Reports

The Project Management reports (listed in Table B-5) are available to users

with a Mercury Project Management application license.

Table B-5. Project Management reports

Report

Definition

Project Cost Breakdown

Shows the costs for a project, and the activities with
which the costs are associated.

Totals include both labor and non-labor costs.
This report is also in the Financial Management category.

Project Cost Details

Shows the cost details for select projects, grouped by
labor/non-labor or operating categorizations.

This report is also in the Financial Management category.

Project Critical Path

Displays the tasks that are on a project’s critical path.

Project Custom Detail

Generated in HTML table format, showing only the
columns that are selected from the header fields and
custom fields based on the selected project.

Project Detail

Queries projects by their header fields.

Project Detail (Filter by Custom
Fields)

Queries projects by their header fields. You can filter the
query using the project’s custom fields.

Project Exception Detail

Lists task details for tasks that have violated user-defined
exception rules.

Project Resource

Lists all resources working on a given project and the
tasks on which they are working.

This report is also in the Resource category.

Project Schedule Change

Compares a project plan with a baseline, or a baseline to
another baseline.

Project Status Detail

Summarizes project statuses of selected projects and
tasks.

Project Summary

Displays all projects that meet the criteria selected in the
header fields.

Project Task Assignment

Shows assignment information for a user or a group of
users.

This report is also in the Resource category.

Project Template Detail

Lists the parameters and parameter details for project
templates.
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For More Information

For more information about Project Management reports, see the Reports
Guide and Reference.
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Resource Management Reports

The Mercury Resource Management™ reports (listed in Table B-6) are
available to users with the licenses indicated in the definition column in the
table.

Table B-6. Resource Management reports

Report Definition

Provides an interface for checking whether Mercury
Demand Management contacts are properly defined.

Available to users with an administration license.
This report is also in the Administrative category.

Contact Synchronization

Lists all resources working on a given project and the
tasks on which they are working.

Available to users with a Mercury Project Management
license.

Project Resource

Shows assignment information for a user or a group of
users.

Available to users with a Mercury Project Management
license.

Project Task Assignment

Lists open requests assigned to different users.

Resource Load by Priority Available to users with a Mercury Demand Management
license.

Lists the users who have been defined in the Mercury IT
Governance system, as well as the security groups
attached to each user.

This report is available to users with any application
license.

This report is also in the Administration category.

User Detall

Shows much of the same information shown on the Work
Allocation definition page—for example, allocation work
item information, budget and actuals to date, charge code
Work Allocation Details allocations, and resource restrictions.

Available to users with a Mercury Time Management
application license.

This report is also in the Time Management category.
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For More Information

For more information about Resource M anagement reports, see the Reports
Guide and Reference.
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Time Management Reports

The Time Management reports (listed in Table B-7) are available to users with
aMercury Time Management application license.

Table B-7. Time Management reports

Report Definition

Summarizes actual time information entered in
Actual Time/Cost Summary non-cancelled time sheets and the calculated charge
dollar totals for each grouping.

Summarizes actual time information entered in

Actual Time Summary non-cancelled time sheets.

Time Sheet Details Summarizes multiple time sheets displays their details.

Summarizes time information entered in non-cancelled

Time Sheet Summary time sheets

Shows much of the same information shown on the Work
Allocation definition page—for example, allocation work
Work Allocation Details item information, budget and actuals to date, charge code
allocations, and resource restrictions.

This report is also in the Resource category.

For More Information

For more information about Time Management reports, see the Reports Guide
and Reference.
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